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1 はじめに

1.1 この資料の使い方

この資料は主に心理系の大学院生が Rで分析できるようになることを目的に作成した。そのため心理統計
については別に学ぶ必要がある。幸い，日本語または英語で読める資料はオンラインにも書籍にも潤沢に存
在している。また臨床心理系の大学院であれば，統計法や研究法の授業があるはずである。

この資料は Rスクリプトと分析結果，およびその解説を記載しているため，長くなりがちである。各章には，
色付きのボックスが配置されている。忙しい人や概要だけ掴みたい人は，まずボックスから読むことをおす
すめする。各ボックスの意味は以下の通りである。

INFO ノート

このボックスは情報提供である。書籍やパッケージなど，読者にとって有益と思われる内容を記載す
る。

LIGHTBULB ヒント

このボックスには各章のうち，ここだけ押さえればとりあえず OKという内容を記載する

Exclamation 重要

取り返しのつかない失敗を避けるための注意喚起，実施にあたって知っておくべきことなど，注意事項
を記載する

2 R・RStudioのダウンロードとインストール

2.1 インストール

Rを使用するだけなら Rの公式サイト（https://ftp.yz.yamagata-u.ac.jp/pub/cran/）で OSに合ったもの
をダウンロードし，インストールすれば良い。R はMacOS，Linux，Windows に対応している。イン
ストールそのもので困ることはとくにないはずであるが，Windows 版のインストールについては東京経
済大学システム課のサイトが丁寧に解説されていて参考になる（URL：https://www.tku.ac.jp/iss/guide/
classroom/soft/rrstudio-desktop.html）。

macOS版の Rについては「続ける」「インストール」を選択し続ければ良い。macOSは CPUが Appleシリ
コンか Intelかで対応する Rのバージョンが異なる。最新の macは Appleシリコンが搭載されているはず
である。もし自分の macの CPUがどちらか分からなければ，メニューバーのリンゴアイコン > このマッ
クについてを選択し，プロセッサを確認すればどちらか分かる。この項目に Intelと書いてあれば For older
Intel Macsのほうをダウンロードする。
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RStudio は R を便利に使うための統合開発環境と呼ばれるソフトウェアである。とくに事情がないかぎ
り，RStudio も一緒にインストールすることをおすすめする。公式サイト（https://posit.co/download/
rstudio-desktop/）から OSに合ったものをダウンロードしてインストールする。筆者は mac0Sを使ってい
るため青いボタンのところに「MACOS 13+」と書かれているが，Windowsや Linuxでアクセスすれば対
応した OSに変わる。

インストールにあたって注意事項がある。R Studio を用いてパッケージをインストールするとき，
WindowsOS の PC のユーザー名に全角文字（ひらがな，カタカナ，漢字，など）が入っていると正常
に実行できないことがある。そのようなケースでは環境変数にパスを指定すると正常に動作するよう
になる。環境変数にパスを指定する方法は慶應義塾大学の松浦寿幸先生の Note が参考になる（URL：
https://note.com/toshi_matsuura/n/n487eecff9632）。

2.2 古いバージョンの入手

古いバージョンの OS を使っている場合，最新の R や RStudio をインストールできないことがある。ま
た，特定の R や R Studio のバージョンで微妙な不具合があることもある。このようなケースでは古いバ
ージョンの R や R Studio を用いる。R はダウンロードサイトにアーカイブへのリンクがあり（macOS：
https://ftp.yz.yamagata-u.ac.jp/pub/cran/，Windows：https://ftp.yz.yamagata-u.ac.jp/pub/cran/），
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対応するバージョンを入手できる。R Studio は上記の画像で示したボタンの下に「download a previous
version」のリンクがあるので，ここから以前のバージョンを入手できる。

なお，分析で使用するパッケージのなかには「このパッケージを使うには Rのバージョンが◯◯以上でない
といけない」のように指定されていることがある。この場合は諦めて最新の OS にしてから R と R Studio
をバージョンアップするか，Google Colaboratoryのような OSに依存しないサービスを用いるかして対
処する。

LIGHTBULB ここを押さえれば OK

Rも RStudioも無料で使える
R の公式サイト（https://ftp.yz.yamagata-u.ac.jp/pub/cran/）と RStudio の公式サイト（https://
posit.co/download/rstudio-desktop/）からダウンロードできる
Rを使うなら一緒に RStudioを使うのがおすすめ

Exclamation 気をつけよう

ユーザー名に全角文字が入っているとライブラリのインストールにトラブルが生じることがある。そ
のようなケースでは松浦寿幸先生の Noteを参考に解決できる。
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3 Rと RStudioの使い方

3.1 R Studio画面の説明

RStudioを開くと，画像のような画面が表示される（筆者は使い勝手の都合でパネルの配置を変更している
ので，インストール初期の配置とは違うかもしれない）。ちなみに背景色や文字色はメニューバーから Tools
> Global Options… > Appearanceで変更できる。修士論文や博士論文などで R Studioの画面を四
六時中見つめる必要があるときは，目に優しいカラーリングにしたほうが何となく疲れが少ない気がする。

画面を説明する。最初に開いたときに表示されるパネルは 3つである。

① ここに入力された内容が計算される。
②色々なタブがあり，いま開いているフォルダ（Files），図（Plots），パッケージの管理（Packages），パッケー
ジのマニュアル（Help）などを表示できる。
③ いまあるオブジェクト（データや関数など）が一覧で表示される。

① に表示されている > のあとに 1+3と入力してエンターを押すと，画像のように [1] 4と表示される。
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Rでは基本的に 1行 1行スクリプトを書いていき，順番に実行することで計算する。このようなユーザーイ
ンターフェースを CUIと呼ぶ。これに対して SPSSや JASPのようにボタンを押していくタイプのものは
GUIと呼ぶ。それぞれ一長一短あり，どちらかが絶対的に優れているというわけではない。

R は python ほど導入の敷居が高くなく，無料で，ユーザー数も多いため日本語・英語の資料が充実してい
る。その気になればかなりマニアックな手法も用いることができる。勉強すれば美しいグラフや論文に掲載
可能な図を作ることもでき (池田 (2024) や Ikeda & Urano (2025) の図はすべて Rで描画した)，分析結果
のレポートを PDFで作ることもできる (この PDFも Rで書いている)。そのため統計解析に限れば Rで十
分な場面が多い。もし将来的に機械学習をやってみたいなら python でも良いかもしれないし，ベイズを手
軽に実施したいなら JASPでも良い。有償ソフトウェアの JMPはアカデミックライセンスが無償化された
ため，教育研究機関に所属している間は申請すれば無料で使える。JASPと JMPはいずれも GUIであり，
どうしても CUIに抵抗がある学生や教職員におすすめできる。

3.2 プロジェクトファイルの作成

最初に画面上部のメニューバーから File > New Project…と選択するとポップアップ画面が表示される
ので，New Directory→ New Projectの順に選択する。最後にプロジェクトの名前（≒フォルダ名）と
場所（＝保存先）を決める。「Browse…」ボタンを押せば見慣れたウィンドウが表示されて，どこにプロジェ
クトフォルダを作るか決められる。今回はどこでも良いので，好きな場所にプロジェクトファイルを作成し
よう。なお，まっさらなプロジェクトファイルを作成するために，左下の「Open in new session」のチェ
ックボックスにはチェックを入れておくことをおすすめする。
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ディレクトリというのはフォルダのようなもので，ここでは R で分析するための新しいフォルダとプロジ
ェクトファイルを作成している。ではなぜ直接新規フォルダの作成をしないのかというと，ただ新規フォル
ダを作ってもプロジェクトファイルがないため，色々と不都合であるためである。たとえば後述するように，
Rに csvデータを読み込む場合，プロジェクトファイルと csvファイルの位置関係が重要になる。また，これ
も後述するように，データセットや画像を出力する場合も，プロジェクトファイルと保存先の位置関係が重
要である。おそらく，ピンとこない人も多いと思われるが，ここではどこで作業しているかはっきりさせるた
めにプロジェクトファイルを作っている，という理解で十分である。

プロジェクトフォルダを見ると，demo.Rproj（拡張子を非表示にする設定なら demo）というファイルがで
きている。一旦 RStudioを閉じても，このファイルを開けばどこで作業しているかはっきりした状態で作業
を再開できる。

3.3 Rスクリプトを書く

CUIで分析するうえで，①に書いていくのは効率が悪い。そこで分析用のコードを書く場所と計算する場所
を分ける。画面上部のメニューバーから File > New File > R Scriptと選択すると，新しい Rスクリ
プトを作成できる。
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Rに計算させる内容は，原則としてここ（エディタ）に書くようにするほうが良い。Rファイルを保存して
おけば分析結果を再現しやすく，公開もしやすい。

R スクリプトを保存するにはエディタパネル上部のフロッピーディスクのアイコンを押すか，他のソフ
トと同じように「Command+s」または「Ctrl+s」で保存できる。最初に保存するときはどんな名前で
保存するか聞かれるので，わかりやすい名前を付ける。例えば前処理用のスクリプトなら cleaning.R や
transform.R，t検定なら t_test.Rのように，ファイル名を見て何をするために書いたスクリプトなのか分
かるようにしておくほうが良い。博士論文用の Rスクリプトだから D_themes.Rとか hakuron.Rに
すると，あとから理由が分からなくなるためおすすめできない。

さっそく何か書いてみよう。エディタに 1 + 3 と書き，その行で「Command+Enter」(macOS) または
「Ctrl+Enter」(Linux / Windows) を押すと，コンソールで計算が始まる。また，画像のように複数行選択
した状態で同じように「Command+Enter」または「Ctrl+Enter」を押せば，選択した行すべてを計算できる。

3.4 四則演算 +α

四則演算はそれぞれ以下のように書く。いずれも一般的な表現である。
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1 # 和
2 1 + 2

[1] 3

1 # 差
2 2 - 1

[1] 1

1 # 積
2 2 * 3

[1] 6

1 # 商
2 10 / 2

[1] 5

その他のメジャーな計算は以下のように書く。記述統計については別に示す。

1 #累乗
2 2^3

3

4 #三角関数
5 sin(0)

6 cos(0)

7 tan(0)

8

9 #対数
10 log(10)

11

12 #自然対数
13 exp(10)

sin()や exp()のように英語 +()で書かれたものを関数と呼ぶ。関数は複数の処理をまとめたもので，ほか
にも t検定を実施する t.test()関数や相関係数を計算する cor()関数がある。平均値を例にとると，平均
値を求めるにはサンプルサイズがいくつかるか数え，総和を求め，総和をサンプルサイズで割る必要がある。
この処理をまとめたものが mean()関数であり，カッコ内にデータを入れることで平均値を返す (カッコ内
に入る数字や文字を引数と呼ぶ)。さらに自前の関数を作ることもできる。
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1 # 自作関数
2 my_function <- function(x){

3 result = log(x) + exp(x)

4 return(result)

5 }

6 my_function(x = 5)

[1] 150.0226

1 # 検算
2 log(5) + exp(5)

[1] 150.0226

関数の引数は x であり，my_function(x = 5) を実行すると log(5) + exp(5) を計算した結果を返す。
分析中に同じような計算を繰り返す場合，その処理を関数にしてしまったほうがスクリプトがすっきりす
る。

3.5 変数という名の箱

計算結果をどこかに置いておいて，あとから再利用したいことがる。たとえば t検定で得た t値を使って効
果量を計算したいとき，いちいち計算し直すのは面倒くさい。そこで計算結果を入れておく箱を用意する。こ
のような箱のことを変数と呼び，箱に入れる操作を代入と呼ぶ。Rでは<-や=で代入する。<-の左側が箱，右
側が中身である。

1 result <- 10 + 5

2 result

[1] 15

上記の例では，「10 + 5」の計算結果を「result」という箱に保存し (1 行目)，その中身を表示している (2 行
目)。さらにこの箱は計算にも使える。

1 result / 3

[1] 5

resultの中身は 15なので，3で割ると答えは 5になる。もちろんこの計算結果を別の箱に入れることもで
きる。
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1 result2 <- result / 3

2 result2

[1] 5

ほかにもデータセットを箱に入れておくこともできる。欠測値を処理したデータと処理前のデータを別々の
箱に入れておくこともできるし，Excelや csvファイルを直接書き換えることがない。そのため「間違って素
データに上書き保存してしまった」のような事故を防ぐことができる。

LIGHTBULB ここを押さえれば OK

Rはコンソールに結果が出てくる。
新しく分析をはじめるときは RStudioでプロジェクトファイルを作ろう。
スクリプトはコンソールでなくエディタに書こう。
関数は処理を 1つにまとめた便利アイテム。
変数はただの入れ物。
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4 データの読み込みと書き出し

4.1 データの読み込み

先に触れた通り，csvや Excelなどからデータを読み込むこともできる。ここでは下図のように同じフォ
ルダにある data.csvを読み込んでみよう。

1 dat <- read.csv("data.csv")#data.csvを読み込んで，datという箱（変数）に入れる
2 head(dat, 6)#読み込めたか確認するために，最初の 6行を表示する

X group_a group_b

1 1 -0.56047565 -0.71040656

2 2 -0.23017749 0.25688371

3 3 1.55870831 -0.24669188

4 4 0.07050839 -0.34754260

5 5 0.12928774 -0.95161857

6 6 1.71506499 -0.04502772

では，以下の画像のように同じフォルダに datasetフォルダがあり，その中に data2.csvがある場合はど
うであろうか。

さきほどと同じように読み込んでみよう。

1 dat2 <- read.csv("data2.csv")

今回は以下のようにエラーが表示された。
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エラー内容を翻訳すると「data2.csv を開きたいって言ってるけどさ，そんなフォルダもファイルもない
よ？」である。このタイプのエラーはファイル名のスペルミスや存在しないファイルを読もうとしたときに
生じる。read.csv("data2.csv")は「このフォルダ内にある data2.csvを読んでね」という指示であり，
Rは忠実に指示に従い，その結果 No such file or direcrotyと言っているのである。

同じフォルダにファイルがない場合，どこにファイルがあるのか教えてあげる必要がある。今回は dataset

フォルダにあるので，以下のように書く。

1 dat2 <- read.csv("dataset/data2.csv")

2 head(dat2, 6)

X group_a group_b

1 1 -0.56047565 -0.71040656

2 2 -0.23017749 0.25688371

3 3 1.55870831 -0.24669188

4 4 0.07050839 -0.34754260

5 5 0.12928774 -0.95161857

6 6 1.71506499 -0.04502772

"dataset/data2.csv" が data2.csvのある場所である。きちんとどこにファイルがあるか教えてあげた
ため，Rもきちんとファイルを読み込んでくれる。融通を利かせてほしいところではあるが，きちんと指示
をしていないこちらに非がある。
あなたが食卓についているとき，「塩をとって」と頼まれたとしよう。食卓の上にも手の届く範囲にも塩がな
ければ，あなたは「ないよ」または「どこにあるの」と返すであろう。ここで相手が「いや，キッチンの右側の上
から二番目の引き出しにあるから。ちゃんと探してよ」と言ったら，「それならせめてキッチンにあるって言
ってよ」となるはずである。Rもきっと同じようなことを思っているはずである。

4.2 データの書き出し

データを分析していると，色々な処理を施したデータを保存しておきたくなることがある。R では
write.csv()でデータを csvファイルとして書き出すことができる。

1 write.csv(dat, "dat2.csv")

2 write.csv(dat, "dataset/dat3.csv")

write.csv(dat, "dat2.csv") を翻訳すると，「dat という箱に入ったデータを dat2.csv という名前の
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csv ファイルとして保存してね」である。実行するとプロジェクトファイルのあるフォルダに dat2.csv が
現れる。

write.csv(dat, "dataset/dat3.csv") を翻訳すると，「dat という箱に入ったデータを dataset フォ
ルダの中に dat3.csvという名前の csvファイルとして保存してね」である。データの読み込みと同じく，デ
ータの書き出しでも場所を指定する必要がある。もし明示しないと，Rは現在のフォルダに書き出す。もし
存在しないフォルダを指定すると，No such file or directory とエラーメッセージが出る。翻訳する
と「保存してねって言われてた場所，ないんですけど？」である。

読み込んだ csvと同じ名称で書き出したら，元の csvファイルは上書き保存される。しかも確認や警告は一
切ない。そのため書き出しの際は注意する必要がある。

4.3 GUIを用いたデータの読み込み

もっと複雑な場所にファイルが存在する場合，住所を全部書くのは大変かもしれない。そのようなケースで
は GUI を使うのも良い選択である。R Studio のメニューバーから File > Import Dataset >From
Text(readr)を選択すると，以下のような画面がポップアップする。

この画面で「Browse…」から目当てのファイルを選択し，画面左下の「Name」に好きな名称を入力し，「Open
Data Viewer」のチェックを外す。「Import」を押すとデータを読み込める。なお画面右下の Rスクリプトを
コピーしてから「Import」を選択するのをおすすめする。Rスクリプトを保存しておけば，次回はこの操作を
スキップしてコードを実行するだけで同じことができるためである。
「Open Data Viewer」にチェックを入れたままにしていると，データを読み込んだときにデータセットが表
示される。よって目的のファイルを読み込めたか確認したい場合は，チェックを入れたままにしておく。

なお，初回にこの操作を実行するとき，readrというパッケージを自動的にインストールするので，インタ
ーネットに接続した状態で実行する必要がある。パッケージの使い方については次に説明する。
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LIGHTBULB ここを押さえれば OK

csvを読み込む関数は read.csv()。
csvを書き出す関数は write.csv()。
どこにあるファイルなのかはきちんと示そう。
GUIでデータを読み込むこともできる。
GUIでデータを読み込んだときも Rスクリプトはコピーしてエディタに貼り付けておこう。
パッケージを使えば csvだけでなく Excelや SPSSも読み込め，多くのデータ形式に対応できる。

Exclamation 気をつけよう

データを書き出すときに同じ名前のファイルがあると，警告も確認もなく上書き保存される。不
幸な事故を避けるために，可能なら出力したデータを保存するフォルダを作り write.csv(data,

"output/data.csv")のように別フォルダに書き出そう。

16



5 パッケージのインストールと読み込み

5.1 パッケージのインストール

Rでは様々な分析が可能である。t検定や相関係数など標準的な計算は，パッケージを追加しなくても実施
可能である。共分散構造分析や項目反応理論など複雑な分析もパッケージなしでできなくはない。しかし非
常に計算が面倒であるため，パッケージを利用したほうが圧倒的に便利である。そこでパッケージの入手に
ついて説明する。

パッケージをインストールするのは簡単であり，原則として install.packages("パッケージ名")を実行
すれば良い。ここでは例として tidyverseというパッケージをインストールする。

1 install.packages("tidyverse")

パッケージの一覧は CRAN の公式サイト（https://cran.r-project.org/web/packages/available_
packages_by_date.html）から確認できる。また，どのようなパッケージがあるか調べたいなら，Googleや
Yahooなどで「◯◯分析 R パッケージ」のように調べると良い。マイナーなパッケージは日本語の検索にヒ
ットしないことがあるため，「**analysis R package」のように英語で検索するとヒットすることがある。

GUIでインストールすることもできる。
「Files」や「Plots」のタブがあるパネルから「Packages」タブを選択する。パネル上部の「Install」ボタンを
選択し，ポップアップした画面にパッケージの名前を入力してインストールする。

このとき，「Install dependencies」のチェックボックスにチェックを入れておく。パッケージを使うとき，
別のパッケージが必要になることがある。このチェックボックスを入れておくと，その必要なパッケージも
一緒にインストールしてくれる。
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5.2 パッケージの読み込み

パッケージをインストールしただけではパッケージを使えない。きちんと R に「このパッケージを使うよ」
と教えてあげる必要がある。具体的には以下の通りである。

1 library(tidyverse)

原則として，この処理は 1 回の分析につき 1 回で良い。しかし R や PC を再起動した場合は改めて
library()を実行する必要がある。別のプロジェクトファイルで分析するときも同様であり，プロジェクト
Aで読み込んだパッケージが，自動的にプロジェクト Bで読み込まれることはない。
install.packages() は原則として 1回だけで良い。ただし Rのバージョンをアップデートした場合は改
めてインストールする必要がある。

ほかにもパッケージを使う方法がある。たとえば psych パッケージに含まれる alpha() がある。この関数
は引数に指定した項目群の信頼性係数 𝛼 を計算する。dataに抑うつ尺度の項目得点が入っているとして，
𝛼 を計算するには

1 # library()を使わず alpha()を使う
2 psych::alpha(data)

3

4 # library()を使う
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5 library(psych)

6 alpha(data)

のように書く。どちらで書いても結果は同じである。パッケージ名と関数名を:: で繋げて書けば，
library() でパッケージを読み込む必要はない。ただしそれぞれに長所と短所があるため，原則として
library()でパッケージを読み込み，例外的に::で繋げて書くのが穏当であろう。関数のなかには，同じパ
ッケージに含まれている別の関数を内部で呼び出しているものもある。このような関数は library()でパ
ッケージを読み込んでおかないと，「そんな関数ないですけど？」とエラーが返ってくることになる。

LIGHTBULB ここを押さえれば OK

install.packages()：パッケージのインストール。原則としてインストールは 1回だけで OK。
library()：パッケージの読み込み。Rを起動するたびに読み込む。使わなくても読み込めることがあ
るが，Rに慣れてから。

INFO 心理系でおすすめするパッケージ

以下は筆者が実際によく使っているパッケージである。

• tidyverse　可視化に特化した ggplot2をはじめとしてデータ分析によく用いるパッケージ
がまとまっている。

– ggplot2　綺麗な図を描画できる。複数のグラフを重ね合わせたり，複数のグラフをパネル
上に並べたりなど，色々なことができる。学術論文に掲載できる水準の図を作ることもでき
る。使いこなすのは大変かもしれないが，うまく表示できるととても気持ち良い。

– deplyr　データセットの操作に便利な関数は何でも揃っている。たとえばグループごとに
平均や分散を計算してデータセットに追加したり，条件ごとに処理を変えたり，やりたいこ
とはだいたい何でもできる。上手く処理できるととても気分がいい。

• psych　記述統計や相関係数，因子分析など心理学でよく用いる分析を簡単に実行できる。
• effectsize　効果量の計算に用いる。
• readxl 　 Excel を読み込むときに必要なパッケージ。オンライン調査で納品されるデータが

Excelであった場合，csvに変換する手間なく読み込めるのがありがたい。
• mirt　項目反応理論を適用するときに使用する。
• lavaan　共分散構造分析に用いる。係数や適合度の計算だけでなく，測定不変性の検証や確認
的因子分析もできる。

• devEMF　図をメタファイルとして保存するときに用いる。メタファイルで保存すると，画質が
ガビガビにならないのが便利である。

そのほかにもマルチレベル分析に lme4を用いたり，ベイズ推定に rstanを用いたり，パッケージには
大変助けられている。

19



6 データ操作

6.1 データ生成

Rにはデータを生成する関数が標準搭載されている。架空のデータセットを作るメリットは様々であるが，
背景にある確率分布が明らかであるためデータ分析の練習にちょうど良い。また分布のパラメタ (正規分布
でいえば平均と分散) を変えて，分布の形状がどのように変化するか学ぶこともできる。さらに架空のデータ
であるため，公開しても問題ない。ここではデータを生成する関数を用い，架空のデータセットを作成する。

1 set.seed(123)

2 n = 100

3 mean1 <- 0

4 mean2 <- 5

5 mean3 <- -2

6 sigma1 <- 1

7 sigma2 <- 5

8 sigma3 <- 0.2

9 x1 <- rnorm(n = n, mean = mean1, sd = sigma1)

10 x2 <- rnorm(n = n, mean = mean1, sd = sigma2)

11 x3 <- rnorm(n = n, mean = mean2, sd = sigma2)

12 x4 <- rnorm(n = n, mean = mean3, sd = sigma3)

13

14 y1 <- x1 * 5 + rnorm(n = n, mean = 0, sd = 1)

15 y2 <- x2 * -4 + rnorm(n = n, mean = 0, sd = 1)

16 y3 <- x3 * 0.1 + rnorm(n = n, mean = 0, sd = 1)

17 y4 <- x4 * -10 + rnorm(n = n, mean = 0, sd = 1)

18

19 z <- c(rep("R", 50), rep("L", 50))

20

21 data <- data.frame(

22 x1 = x1,

23 x2 = x2,

24 x3 = x3,

25 x4 = x4,

26 y1 = y1,

27 y2 = y2,

28 y3 = y3,

29 y4 = y4,

30 z = z

31 )
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32

33 head(data)

x1 x2 x3 x4 y1 y2 y3

1 -0.56047565 -3.5520328 15.994052 -2.143048 -2.8759343 13.606238 2.67341743

2 -0.23017749 1.2844185 11.562065 -2.150538 -2.3195389 -6.131373 1.12885952

3 1.55870831 -1.2334594 3.674275 -2.187708 7.1587933 5.960623 0.33409713

4 0.07050839 -1.7377130 7.715970 -2.210503 0.3237004 7.701913 -0.74447059

5 0.12928774 -4.7580928 2.928300 -2.087432 1.3171346 17.523205 1.08321537

6 1.71506499 -0.2251386 2.618766 -1.933764 6.9247784 0.805407 0.05114237

y4 z

1 20.70227 R

2 19.96494 R

3 21.18398 R

4 22.22388 R

5 19.50961 R

6 19.92762 R

rnorm()は正規分布に従う乱数を生成する関数である。引数は n (サンプルサイズ)，mean (母平均)，sd (母
分散)の 3つである。乱数を再現するために set.seed()を使っている。もし set.seed()を使わずに乱数
を生成すると，データ生成のたびにデータが変化してしまい，同じ結果を得られなくなる。

c()は数字や文字を 1つにまとめる関数である。ここでは最頻値を計算するために，新しく xという箱に整
数を 10個入れた。文字を入れる場合は" "で囲って c("Orange", "Apple", "Banana")のように書く。

rep() は数字や文字列をたくさん生成するための関数である。ここでは rep("R", 50) で R を 50 個，
rep("L", 50)で Lを 50個生成している。それぞれの文字を c()でまとめることで，Rと Lが計 100個入
った箱 zというを作っている。

data.frame()は複数の変数を束ねてデータフレームという形にする関数である。データフレームの詳細は
省くが，箱がバラバラの状態では分析しづらいため，整理整頓して棚に収納したような状態だと理解すれば
良い。棚のこの列には x1が入っていて，別の列には y1が入っていて……という状態になっている。

6.2 要素へのアクセス

いま dataという大きな箱には x1〜zまで 9つの小さな箱が入っている。可視化したいときや記述統計を求
めたいときは，小さな箱のほうに用事がある。小さな箱に用事があるときは$を使って呼び出すことができる
(例：data$x1)。また，何列目かを指定することで呼び出すこともできる (例：data[, 1])。さらに列番号を
用いれば，複数列にアクセスできる (例：data[, 1:4])。

この方法では面倒だということであれば，attach() を用いることもできる。attach(data) と書けば，
「dataの変数に用事があるんですけど」と Rに教えることができる。対になる関数は detach()であり，用事
がなくなり次第 detach(data)と書き，「もう大丈夫です」と教えてあげる必要がある。意外と detach()を
忘れることが多いので，注意してほしい。
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1 #「$」を使ってアクセス
2 head(data$x1, 3)#先頭の 3行だけ表示。以下同じ。

[1] -0.5604756 -0.2301775 1.5587083

1 head(data$y3, 3)

[1] 2.6734174 1.1288595 0.3340971

1 # 列番号を使ってアクセス
2 head(data[, 1], 3)

[1] -0.5604756 -0.2301775 1.5587083

1 head(data[, 7], 3)

[1] 2.6734174 1.1288595 0.3340971

1 # 列番号を使って複数行にアクセス
2 head(data[, 1:4], 3)

x1 x2 x3 x4

1 -0.5604756 -3.552033 15.994052 -2.143048

2 -0.2301775 1.284419 11.562065 -2.150538

3 1.5587083 -1.233459 3.674275 -2.187708

1 head(data[, 5:8], 3)

y1 y2 y3 y4

1 -2.875934 13.606238 2.6734174 20.70227

2 -2.319539 -6.131373 1.1288595 19.96494

3 7.158793 5.960623 0.3340971 21.18398

1 # attach()を使ってアクセス
2 attach(data)

3 head(x1, 3)

[1] -0.5604756 -0.2301775 1.5587083

1 head(y3, 3)

[1] 2.6734174 1.1288595 0.3340971
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1 detach(data)

attach(data)は detach(data)を実行するまで継続する。そのため次のようなケースでは，データの取り
違えが生じる可能性がある。結果がどうなるか確かめてほしい。

1 A <- 3

2 x <- data.frame(

3 A = 10,

4 B = 11

5 )

6

7 A

8

9 attach(x)

10 A

11 detach(x)

12

13 A

最初に Aを表示すると，3と表示される。しかし attach(x)を実行してから Aを表示すると，xの A列に
ある数字の 10が表示される。使い終わったら detach(x)を実行しておかないと，3のつもりで Aを用いて
いるのに内部では 10として処理され続けることになる。

さらに以下のようなミスもよくある。

1 x <- data.frame(

2 A = 10,

3 B = 11

4 )

5 attach(x)

6 x$new_number <- 13

7

8 new_number

9 detach(x)

このスクリプトを実行すると，4 行目の new_number を表示しようとしたときに Error: object

'new_number' not found とエラーメッセージが出力される。attach(x) を実行したあとに x へ追
加した変数は，変数の名前だけでは呼び出せない。この場合は以下のように書き換えると正しく機能する。

1 x <- data.frame(

2 A = 10,

3 B = 11
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4 )

5 attach(x)

6 x$new_number <- 13

7 detach(x)

8

9 attach(x)

10 new_number

[1] 13

1 detach(x)

上記のスクリプトでは x に変数を追加したあとに一旦 detach(x) を実行し，改めて attach(x) を実行し
ている。こうすることで新しく追加した変数を変数名だけで呼び出せる。

6.3 条件に一致するデータの抽出

有効対象者のみを分析対象にしたい場合，データセットの中から条件に一致するデータだけを抽出する必
要がある。このようなときは subset()を用いる。subset()はデータセットから条件に一致する行を抜き
出す関数である。1つ目の引数で抽出元のデータセットを指定し (上記のスクリプトでは data)，2つ目の
引数で抜き出す条件を指定する (上記のスクリプトでは data$z == "R")。
以下のように，2つ目の引数には文字以外も用いることができる。

式 例 例の意味

>= a >= 2 aが 2以上である
<= a <= 2 aが 2以下である
> a > 2 aが 2よりも大きい
< a < 2 aが 2未満である
== a == 2 aが 2と等しい
!= a != aが 2でない

さらに複数の条件を組み合わせることもできる。たとえば z が R (data$z == "R") で x1 が 0 未満
(data$x1 < 0) である行を抽出したければ，2つの式を&でつないで subset(data$z == "R" & data$x1

< 0)とする。もし zが L (data$z == "L") または x2が 1以上 (data$x2 >= 1) の行を抽出したいなら，
2つの式を|でつないで subset(data$z == "L" | data$x2 >= 1)とする。

6.4 列の追加

質問紙を使った研究では，項目得点の平均値を尺度得点とすることがある。このようなケースではデータに
変数 (列) を追加する。また，同じ人を対象に 2回調査を実施した場合，1回目と 2回目で別のデータセット
を作っていることがある。このようなケースでも列方向にデータを追加する作業が必要になる。
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まず前者のパタンについて Rで実施する。平均値や尺度得点のような計算結果を列に追加するには，$を用
いる。たとえば上図のように x1〜x4の平均を x_meanとして dataに追加する場合，以下のようにする。

1 data$x_mean <- (data$x1 + data$x2 + data$x3 + data$x4) / 4

2 head(data, 5)

x1 x2 x3 x4 y1 y2 y3

1 -0.56047565 -3.552033 15.994052 -2.143048 -2.8759343 13.606238 2.6734174

2 -0.23017749 1.284419 11.562065 -2.150538 -2.3195389 -6.131373 1.1288595

3 1.55870831 -1.233459 3.674275 -2.187708 7.1587933 5.960623 0.3340971

4 0.07050839 -1.737713 7.715970 -2.210503 0.3237004 7.701913 -0.7444706

5 0.12928774 -4.758093 2.928300 -2.087432 1.3171346 17.523205 1.0832154

y4 z x_mean

1 20.70227 R 2.4346237

2 19.96494 R 2.6164420

3 21.18398 R 0.4529540

4 22.22388 R 0.9595658

5 19.50961 R -0.9469842

head()で dataの先頭 5行まで表示すると，たしかに追加されているのが確認できる。

その他，2つのデータセットを列方向に追加するには cbind()を用いる。

1 # データセットを分割
2 data_x <- data[1:4]# dataから x1〜x4だけ抜き出す
3 data_y <- data[5:8]# dataから x1〜x4だけ抜き出す
4

5 # データセットを列方向にくっつける
6 data_xy <- cbind(data_y, data_x)

7 head(data, 5)

x1 x2 x3 x4 y1 y2 y3

1 -0.56047565 -3.552033 15.994052 -2.143048 -2.8759343 13.606238 2.6734174

2 -0.23017749 1.284419 11.562065 -2.150538 -2.3195389 -6.131373 1.1288595
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3 1.55870831 -1.233459 3.674275 -2.187708 7.1587933 5.960623 0.3340971

4 0.07050839 -1.737713 7.715970 -2.210503 0.3237004 7.701913 -0.7444706

5 0.12928774 -4.758093 2.928300 -2.087432 1.3171346 17.523205 1.0832154

y4 z x_mean

1 20.70227 R 2.4346237

2 19.96494 R 2.6164420

3 21.18398 R 0.4529540

4 22.22388 R 0.9595658

5 19.50961 R -0.9469842

cbind()は 2つのデータセットを列方向に結合する関数であり，引数で指定した 2つのデータセットを横
向きに並べて 1つにまとめることができる。そのため，行数が同じ必要がある。

6.5 行の追加

学校 Aと学校 Bで同じ質問紙を配布・回収したとき，学校別にデータセットを作ることがある。このように
2つに分かれたのデータセットを 1つにまとめるときは，行方向にデータを追加する操作が必要になる。

上図のようにデータセットを結合するときは，rbind()を用いる。

1 # zの値でデータセットを 2つに分ける
2 data_R <- subset(data, data$z == "R")#zが Rの行だけ抜き出す
3 data_L <- subset(data, data$z == "L")#zが Lの行だけ抜き出す
4

5 # データセットを行方向にくっつける
6 data_RL <- rbind(data_L, data_R)

rbind()は 2つのデータセットを行方向に結合する関数であり，引数で指定した 2つのデータセットを縦
向きに並べて 1つにまとめることができる。そのため列の名前 (変数の名前=小さい方の箱の名前) が同じ
である必要がある。
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LIGHTBULB ここを押さえれば OK

正規分布に従うデータは rnorm()で生成できる
変数名でデータセットの要素にアクセスするには$用いる
列番号を使ってデータセットの要素にアクセスするにはデータセット [, 行番号]のように書く
subset()を使えば条件に一致した行を抽出できる
列を追加するにはデータセット$新しい変数 <- 計算のように書く
データセットを融合するには cbind() (横方向に融合)または rbind() (縦方向に融合)を使う

27



7 練習問題

12 × 13と 12÷13を計算しよう。

20 * 10の計算結果を calc変数に格納しよう。

psychパッケージをインストールしよう。

psychパッケージを読み込もう。

適当な場所に data.csvを保存して，その場所からデータを読み込んで atadという箱に入れてみよう。

group_aを 4倍した値を group_a4という箱に入れて，atadに追加してみよう。

atadという箱に入ったデータを dat4.csvという名前で書き出そう。
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8 回答例

1 # 12 × 13と 12÷13を計算しよう。
2 12 * 13

3 12 / 13

4

5 # 20 * 10の計算結果を calc変数に格納しよう。
6 calc <- 20 * 10

7

8 # psychパッケージをインストールしよう。
9 install.packages("psych")

10

11 # psychパッケージを読み込もう。
12 library(psych)

13

14 # 適当な場所に data.csvを保存して，その場所からデータを読み込んで atadという箱に入れてみよう。
15 atda <- read.csv("myfile/data.csv")

16

17 # group_aを 4倍した値を group_a4という箱に入れて，atadに追加してみよう。
18 atad$group_a4 <- atad$group_a * 4

19

20 # atadという箱に入ったデータを dat4.csvという名前で書き出そう。
21 write.csv(atad, "dat4.csv")
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